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1 Overview

1402.0043.12

Acoustic Measurements on Mobile Phones

The acoustic transmission and reproduction quality of a mobile phone is its
most important characteristic in everyday use. Even the most visually
appealing design and wonderfully sophisticated operating concept are not
much use, when the user cannot or can hardly understand what is being said
at the other end.

Instruments and methods for measuring acoustic characteristics are therefore
essential tools for assessing the quality and suitability of a mobile phone.

Since a digital audio interface is no longer required even for type-approval tests
on 3rd generation mobile phones, it was necessary to develop new test methods
that allowed measurements to be performed via the air interface and the normal
speech coder and decoder. The test signals have to simulate human voice in the
frequency and time domain to be able to test the mobile phone in the normal
operating mode with DSP assessment such as voice activity detector (VAD),
noise suppression, echo cancellation, etc switched on.

These tests are based on new standards for 3GPP mobile phones. The test
methods are stipulated in 3GPP TS 26.132 and the values to be attained in 3GPP
TS 26.131.

As of release 4 of the GSM 51.010 standard (successor to GSM 11.10), even
GSM mobile phones may be tested to 3GPP TS 26.132.

The R&S UPV-K9 and R&S UPV-K91 options (UMTS/GSM Mobile Phone Tests)
of the Audio Analyzer R&S UPV, called herein below “UPV”, is now available for
measuring the acoustic characteristics of 3GPP and GSM mobile phones. The
measurements are in line with 3GPP TS 26.131, TS 26.132 and TS 51.010 and
have been validated by an independent test house for type-approval testing on
UMTS and GSM mobile phones.



Acoustic Measurements on Mobile Phones

2 Preparation and Start of the Application Software

Required Measuring Instruments and Accessories

The Audio Analyzer R&S UPV with the following options is required for the
measurements:

» Base Software for Mobile Phone Tests R&S UPV-K9
*  UMTS/GSM Mobile Phone Tests R&S UPV-K91 (version 1.0)

The GSM mobile phone under test is connected via the RF interface using
the Universal Digital Radio Communication Tester R&S CMU200, called
herein below CMU 200. This tester simulates a base station for the mobile
phone so that a call can be set up. For GSM, the CMU200 must be
equipped with the options CMU-B21 (signalling unit), CMU-B52 (speech
coder/decoder) and the appropriate software options for the GSM band
used. For WCDMA, the option CMU-B69 is required. The firmware level in
the CMU200 must be 3.50 or higher.

Acoustic devices such as an artificial mouth, artificial ear and other
accessories are required for the measurements. The following equipment
from Briel & Kjeer or G.R.A.S. is normally used:

Device Description Type (examples)

Telephone test head Device for fixing the DUT in the B&K 4602B

prescribed position

IEC 711 type occluded ear simulator | B&K 4195 (type 3.2)
with adapters for connection to the
ear piece of the DUT

Wideband ear simulator

Artificial mouth

Special loudspeaker for simulation
of the mouth

B&K 4227 or
G.R.A.S. 44AB or
44AA (with power
amplifier)

Head and torso simulator

Head and torso simulator with
artificial ear (type 3.3) and artificial
mouth, may be used alternatively to
the abovementioned devices

B&K 4128 D

Measurement microphone

2" or ¥4 measurement microphone
for measurement of artificial mouth
output during calibration. This
microphone can use the preamplifier
of the artificial ear.

B&K4191 (free field,
may be used for
hands free tests),
B&K 4192 (pressure
field, may be used
with type 1 art. ear)

Acoustic calibrator

Sound level calibrator for calibrating
the measuring microphone

B&K 4231

Microphone power supply

Power supply and preamplifier for
the measuring microphone

B&K 2829, 5935L or
2690A0S2

or G.R.A.S. 12AD or
12AA

Note: With the amplifier set to 0 dB, the microphone power supply B&K
2690A0S2 produces too much noise for measuring idle noise and
distortion. It is therefore advisable to set a gain of 20 dB.

1402.0043.12 6 E-1
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Acoustic Measurements on Mobile Phones

A cable with a BNC connector and special small or angled banana plugs is
required for connecting the artificial mouth, as the space between the
mouth connectors and the test rack (B&K 4602B) is too small for common
banana plugs.

The transformer supplied with option R&S UPV-K9 must be connected
between generator output 1 of Audio Analyzer R&S UPV and the connector
of the artificial mouth. The transformer matches the impedance of the
loudspeaker in the artificial mouth to that of the generator output of the
R&S UPV. Without this transformer, the available power is too low for
driving the artificial mouth.

Alternatively, a power amplifier, preferably with a voltage gain of approx.
0 dB, can be connected between generator output and mouth instead of the
transformer. In this case, the gain set must be kept absolutely stable after
calibration.

A cable with male (analyzer) and female (generator) XLR connector is
supplied for connection to the "Speech" connector of the Digital Radio
Communication Tester CMU.

UPL Analyzer Generator

Fig. 1 Assignment of 9-contact speech connector on CMU front panel

This cable is configured for connection to link handler #1 in the CMU.
Depending on the CMU hardware, link handler #2 in the CMU can also be
used for GSM; in this case, the supplied adapter must be inserted between
the cable and the speech connector on the CMU.

Caution: Ifthe CODEC calibration fails, the adapter has most likely to be
inserted.

The CMU connects pin 1 of the R&S UPV generator output to
the equipment grounding conductor of the mains. If an external
power amplifier is used, care must be taken that the external
power amplifier does not connect R&S UPV generator output pin
2 to the equipment grounding conductor of the mains. If
available, a balanced connection to the power amplifier should
be preferred.

An external power amplifier should be switched on after the
R&S UPV-K9 main program has been started, and switched off
before the program is ended. This prevents the artificial mouth

7 E-1



Acoustic Measurements on Mobile Phones

from undue power loading by setups which are loaded external
to the application.

An external USB keyboard and a mouse must be connected to
the R&S UPV.

Caution: R&S UPV-K9 does not support the use of headphones. Do not
connect headphones to the R&S UPV during mobile phone
tests. High level signals may be present at the headphone
connector.

The program required and the associated files are on an installation CD
supplied with the R&S UPV-K91 option. The audio analyzer must meet the
following firmware requirements:

* R&S UPV firmware version 1.4.1.210 or higher
* Option R&S UPV-K9 installed
e Option R&S UPV-K91 installed.

Installing the Software

The application program requires option keys K9 and K91 to be installed.
The keys are installed in the factory in case a new R&S UPV is ordered
together with these options. If the options are ordered separately, the keys
are part of the delivery. Please refer to the R&S UPV Operating Manual for
details on the installation of option keys.

Copy the files R&S UPV-K91.msi, Setup.Exe and Setup.lni to a
subdirectory on the R&SUPV hard disk (e.g. “D:\R&S
Software\K91\Version 1.0”) and start “Setup.Exe”. Follow the instructions of
the installer on the screen.

Test Setup
| | [T rreerom—
- EET L TS Microphone
< : =g Supply
o :- HH:J] =]I "x C\ C"‘i {’:;1
T /0033 ' ;
5’ o he o a1 0w art ear

i Bl = 'Te ?&i % 1
| 8 w —
tl'ransformej D(j

art mouth

G=T=T=T=T=T=1=1=]

RF to Mobile

Fig. 2 Test setup and connection of external components
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Acoustic Measurements on Mobile Phones

Starting the Application Software

After installation, the program cn be started by double-clicking the Icon
“UPV-K9 Mobile Phone Tests” or by clicking “R&S UPV Applications >
UPV-K9 Mobile Phone Tests” in the “Programs” menu.

At the fist start of the program, selection windows appear for the standard
according to which the measurements should be made, and for the artificial
ear and artificial mouth used.

Select Standard

none

AGFP T551.010 Type 1 ear

AGPF T526.132 handset narraw

r AllEwr ol statdarnd
mEasurenments

[T D not show this dislog again

Cancel | ] 3

e

Fig. 3 Query window for selection of applied standard

If “none” is selected in the standard selection window, all measurements
appear in the “Measurement” menu. If a standard is selected, all
measurements appear in the “Measurement” menu, but compliant
measurements are checked in the menu. If “Allow only standard
measurements” is checked, non-compliant measurements are suppressed
in the Measurement menu.



Acoustic Measurements on Mobile Phones

Select Ear Simulator

Type 1

Type 3.2 Low Leak

Type 3.2 High Leak

Type 3.3

Type 3.4

Elechic connection

[nduction cail

[T D not show this dislog again

Cancel | Ok I
y

Fig. 4 Query window for selection of artificial ear

®Eelect mouth type  [H[=]

LRGFITU-T P.51

HATSITU-T P53

Genenc speaker

Elechic connection

[T Do ot show this dislog again

Cancel Ok J//
e

Fig. 5 Query window for selection of artificial mouth

When the checkbox “Do not show this dialog again” is checked, the
corresponding selection window will not appear at the program start in
future. However, the selection is still available in the “Options” menu (see
below). After the last of the three selection windows has been closed, the
main window of the R&S UPV-K9 opens.
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Acoustic Measurements on Mobile Phones

4_’} Telephone Tests - [O] x]

File Data Calbration Measurement Sequence Report Options Help

Test results overview

Date and time h e | Test object Wesdi | Comenent -
» 9/8/2006 317:26 PM 3GPP Recerving Handset, nom. Yol Test mobde 4 PASS
9/8/2006 31813 PM 3GPP Ide channel notse receiving, nom. vol Test mobie 4 PASS
9/8/2006 318:32 PM 3GPP Sidetone Masking Rating Test mobde & FAIL
9/8/2006 31910 PM 3GPP Distortion receiving Test mobde & PASS
9/8/2006 320:10 PM 3GPP Sendng Handset Test mobie & PASS
9/8/2006 3:20:49 PM 3GPP Distortion sending Rel. & Test mobide A PASS
9/8/2006 3:21:51 PM 3GPP Ide channel noize sending Test mobde A PASS
9/8/2006 3:22:43 PM 3GPP Receiving Handset, min. Vol Test mobie & PASS
9/8/2006 32511 PM 3GPP Receiving Handset, max. Vol Test mobie & PASS
9/8/2006 3:25:42 PM 3GPP Ide channel noise receiving, max. vol Test mobie & PASS
~|9/8/2006 3.27:07 PM 3GPP Echao loss with training Test mobie & PASS
~|9/8/2006 3.28:14 PM 3GPP Stabilty margin Test mobie 4 PASS
9/8/2006 4:05:14 PM 3GPP GSM Rel 4 Receiving Handset, nom. ¥ Test mobde B PASS
9/8/2006 4:16:23 PM 3GPP Sidetone Masking Rating Test mobde B FPASS
9/8/2006 4.19:38 PM 3GFP Ide chanred nosse 1eceiving, nom. vol Test mobde B FAIL
9/8/2006 4:20:01 PM 3GPP Distortion receiving Test mobde B PASS
9/11/2006 542 48 PM 3GPP Recening Handset, nom. Vol Sample test obyect FAIL
9/11/2006 5:45:06 PM 3GPP Ide channel noise receiving. nom. vol Sample test object PASS
_ |9N1/2006 5:47:31 PM 3GPP Receiving Handset, max. Vol Sample test object PASS
9/11/2006 5:48:03 PM 3GPP Ide channel nosse receiving, nom. vol Sample test object PASS
911/2006 5:48:54 PM 3GPP Distortion receiving Samgle test object PASS
911/2006 5:50:50 PM 3GPP Echo loss with training Samgle test object PASS
911/2006 5:54:40 PM 3GPP Echo loss with training Sample test object PASS |
9M11/2006 5:57:12 PM 3GPP Sidetane Masking Rating Sample test object FAIL
911/2006 5:58:39 PM 3GPP Sendng Handset Sample test object PASS
9/11/2006 6:00:22 PM 3GPP Distortion sending Rel. B Sample test object PASS -
QM1 P00 C0% I Dk W00 1l ak sl wmcan smmmdio s € mmnmle sl bt DACC
| | (B
\3GPP HandS Namow | Type 32 Low Leak At Ear [CMU / CRTU Sample test object
| e | | | e |
measurement sequence

Fig. 6 Main window

Initially the data grid in the center of the screen which shows the result
overview is empty. The screenshot below shows an example after a
number of measurements have been made.

11
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Acoustic Measurements on Mobile Phones

3 Operating Concept

1402.0043.12

R&S mobile phone tests consist of at least two components. R&S UPV-K9
provides the main user interface window, general settings, calibration
routines, data handling, automatic sequencing and reporting tools.

Separate options for different standards (R&S UPV-K91 for 3GPP GSM
and WCDMA tests) provide test macros for basic measurement types
defined in the standards. Each measurement type provides a set of
parameters (R&S UPV setup files, limits etc.) which are defined in
separated measurement definition files, one for each test case.

Options (General settings)

The “Options” menu in the main window allows to change a set of general
settings like ear type and mouth type used which are valid for all or at least
a plurality of the tests.

“Measurement frequency range” allows to enter the frequency range in
which the artificial head is calibrated. In general this will be 100 Hz to
10 kHz which is the default. “Number of points” specifies the number of
(logarithmically spaced) frequencies measured for the mouth equalization.

“Standard” allows to select one of the available standards. Measurements
belonging to this standard will be checked in the measurement menu. If
“Allow only standard measurements” is checked, it is not possible to start
single measurements which do not belong to the standard.

If “Select standard at startup” is checked, the selection window for the
standard is opened at each start of the program.

“Ear simulator” allows to select the type of ear simulator used. For details
on the handling of calibration data see section 4 “Calibration” below.

If “Select ear simulator at startup” is checked, the selection window for
the ear simulator is opened at each start of the program.

“Artificial mouth” allows to select the type of artificial mouth used. For
details on the handling of calibration data see section 4 “Calibration” below.

If “Select artificial mouth at startup” is checked, the selection window for
the artificial mouth is opened at each start of the program.

“System simulator” allows to select the type of system simulator used.
For details on the handling of calibration data see section 4 “Calibration”
below.

If “Select system simulator at startup” is checked, the selection window
for the system simulator is opened at each start of the program.

If “Show operator instructions” is checked, instructions to the operator
are displayed in a window before the measurement starts. The operator
may be prompted to position the mobile in a defined way or to set the
volume to a certain setting.

“Report settings” allows to define the type of information which should
appear in the reports. For details on reporting, see section 8 below.

If “Generate temporary export files” is checked, each measurement
macro created “result.exp” with result value and verdict, and, if applicable,
“abscurve.exp” and “relcurve.exp” files with curve data in ASCII format.

12 E-1
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Acoustic Measurements on Mobile Phones

Calibration Devices

R&S UPV-K9 allows to simultaneously store calibration values for multiple
individuals of the same type. This allows to switch devices without the
requirement for re-calibration. However, regular re-calibration is
recommended in order to assure the correct function of the used devices.

@Telephune Tests

File Data | Calibration Measurement Seguence Report  Options  Help

[Crate Microphone rement title

3
iFici 3 .
3 9/a/ el ey Feceiving Handset, nom. Yol
DRP ko ERP correckion  k 2 W
9/8¢ Ficia - , dle channel noise receiving, nom. v
9/8/ Art.; ieial Mout idetone Masking Fating
9/8/ Gereis Dlistortion receiving

3¢5/ I e e

Distartion sending Rel &

dle channel noize zending
Feceiving Handzet, min. Wol.
eceiving Handset, maw. Wal.

[ N e Ta ta T e Tl Tl T ] ArEr 1 1

. . ,
5,8/ Electric connections

5,8/ Mew Device

g8/ Select Device

g/8/ Show all walues

Fig. 7 Calibration menu

For every device to be calibrated, an entry must be created using
“Calibration > New device” in the main menu. This menu item opens an
entry window to specify the calibrated device. A category of device must be
chosen from the combo box on top. Type, manufacturer and serial number
are entered into the text boxes below. The entries are confirmed by clicking
on the “Save and close” button.

@Ealihrated De -0 x|

Ilzage

| =l
Type

b anufacturer

Senal Mumber

Cancel | | Save and cloze I
3

Fig. 8 Input window for information about calibrated device
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Before a device can be calibrated or used, it must be selected with
“Calibration > Select device” in the main menu. Clicking on this item opens
a window with a table of all entered devices.

| Date and Time | Calib. value

Default 9/8/2006 312 PM 3 304471930505 DAIGPPACa
| |Diffuse field microphone Default 9/8/2006 3:.05 PM -17.915721 70257 DAIGPPACa
| |Electic connection replacing decoder Default 7/13/2006 554 FM [rdl] DA3GPPACa
| |Electic connection replacing decoder Default T/13/2006 5:07 FM a5 D:AIGPPACa
|| Electiic conmection replacing encoder Default TAY2006554PM  frudl) D:\3IGPPACa
| |Electic connection replacing mouth Default 7/13/2006 551 PM [rdl) D:A3GPPACa
| |Encoder Default 9/8/2006 312 PM 1073 76998233746 D:A3GPPACa
| |Free field microphone Default 6/7/2006 3:50 PM (o) D:A\IGPPACa
| |Genesic speaker Default TN3/2006 £33PM (e D:AGPPACa
[ |[HATS ITU-T P58 Art. Mouth Default B/7/2006 347PM ] DAIGPPACa
| |HATS Type 334t Ex Default E/7/2006 352 PM [rudl) DA3GPPACa
| |HATS Type 34 Art Ear Default 6/7/2006 3:54 PM [rudl] DAIGPPACa
| |Induction coil (input) Default TAV06G04PM  frudl) DAIGPPACa
| irput digial Default B/7/2006 343PM ) DAIGPPACa
| |LAGPITU-T P51 At Mouth Default 9/8/2006 3.06 PM 178.055148772134 DA3GPPACa
|| Output dighal Default B/7/2006 350PM frudl) D:A3IGPPACa
| |Tupeldst Ear Default 9/8/2006 3:37 PM -17.9190761 5662 D:A3GPPACa
| | Type 3.2 High Leak At Ear Default 6/7/2006 351 PM [rudl) D:A3GPPACa
| |Type32Lowleak AnEx Bk kS 1708754 9/8/2006 5:07 PM (rul) D:\3GPP\Ca
| |Type 32Low Leak AtEar Default 9/8/2006 308 PM -16.84842729569 D:AIGPPACa
- Tvoe 3.2 Low Leak AtEa GRAS. RADDSE & RA 26740 & 4636 9/8/2006 517 PM frudll | D'\EPP\lﬂﬂ

[Setect Usage Type = Select | Cancel | | Ok JI

Fig. 9 Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected.
Subsequently the table is reduced to available devices in this category. At
first startup, there is only a “Default” device for each category, but when
more devices have been created with the “New device” function, a choice
will be available in this view. In this state a row in the table can be marked
with @ mouse click on its left end. A mouse click on the button “Select”
selects this device for the associated usage.

| Type |SeiielNo. | Dale and Time | Calb, value
Type 3.2 Low Leak ArtEar 4195 1708754 9/8/2006 507 PM [rudl)
Type 3.2 Low Leak At Ea Default 9/8/2006 308 PM -16.84842729569
Type 3.2 Low Leak Art Ear RADDSE & RA 26740 & 4636 9/8/2006 517 PM [rudl)

[ -] Sekct | wll“_le

Fig. 10 Selection window for particular device type

Subsequently this procedure may be repeated for other categories. Finally
all selections are confirmed by clicking the “Ok” button.

All calibration data are stored on the R&S UPV hard disk and are therefore
automatically available again after every restart. The calibration values for
the R&S UPV-K9 option are stored independently of other options.

All calibration routines below require as pre-requisite that a device for the
respective usage has been generated and selected.

14 E-1



1402.0043.12

Acoustic Measurements on Mobile Phones

To simplify the procedure for the case that it is not intended to use multiple
devices of the same category nor to include information about the used
devices into a report, there is a “Default” device selected for each device
type or category after the first start of the program.

Microphone Calibration

» Insert the measuring microphone fully into the adapter of the sound
level calibrator and switch on the calibrator.

Note: After inserting the microphone, wait about 10 s to allow for
static pressure equalization.

» Call the test routine with “Calibration > Microphone - Free field” or
“Calibration - Microphone - Diffuse field” from the main menu,
depending on the microphone.

Microphone calibration

Connect microphone 1o analyzer input 1.
Insert microphone into calibrator using
adapter UCO210 and switch on calibrator.

[ Calibration level increazed by 20 dB [hot walidated]

y

Fig. 11 Initial window of microphone calibration

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in
the calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa,
display = 120 mV/Pa). If a conditioning amplifier with 20 dB gain
(recommended value) is used, the displayed sensitivity must be about
10 times higher. If the voltage measured is below 3 mV, an error
message is displayed. Possible error sources are, for example, a
switched-off microphone power supply or a disabled calibrator. In this
case, the program requests that the test be repeated. After switching on
the microphone power supply, wait approx. 20 s before restarting the
measurement with RUN.

15 E-1
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Calibration of Artificial Ear

Prior to the measurements, the absolute sensitivity of the microphone in the
artificial ear must be determined using a sound level calibrator such as the
Briel & Kjeer 4231 with a sound pressure level of 94 dBSPL or a sound
pressure of 1 Pa at 1 kHz.

Calibration of Ear Type 1
> Switch off the microphone power supply.

Note: The 200 V polarization voltage of the microphone may cause
a slight electric shock. The current is harmless, but the
microphone preamplifier may be damaged.

» Remove the microphone from the artificial ear.

» Screw back the microphone capsule and switch on the operating
voltage.

» Insert the microphone fully into the adapter of the sound level
calibrator and switch on the calibrator.

Note: After inserting the microphone wait about 10 s to allow for
static pressure compensation.

» Select “Calibration - Artificial ear = Type 1” from the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in
the calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa,
display = 120 mV/Pa). If a conditioning amplifier with 20 dB gain
(recommended value) is used, the displayed sensitivity must be about
10 times higher. If the voltage measured is below 3 mV or fluctuating by
more than 0.2 dB, an error message is displayed. Possible error sources
are, for example, a switched-off microphone power supply or a disabled
calibrator. In this case, the program requests that the test be repeated.
After switching on the microphone power supply, wait approx. 20 s
before restarting the measurement.

The reference value measured is stored in a file on the hard disk and
used for all subsequent measurements when the same artificial ear type
1 is used as currently selected.
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Calibration of Ear Type 3.2 Low Leakage

>

>

Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

Select “Calibration = Artificial ear - Type 3.2 Low Leak” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2L is
used as currently selected.

Reading the Calibration Data of the Artificial Ear of Type 3.2L:

The frequency response of the artificial ear of type 3.2L is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_LL.ADA” from the manufacturer’s calibration disk to a

USB stick or a CD-ROM or make this file available on a network drive via
LAN.

Call the routine “Calibration > DRP to ERP Correction 2> Type 3.2 Low
leak”. Browse to the file “OES_LL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer,
or when the “3GPP” directory has been renamed or removed.

Calibration of Ear Type 3.2 High Leakage

>

>

Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

Select “Calibration > Artificial ear > Type 3.2 High Leak” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
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microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2H is
used as currently selected.

Reading the Calibration Data of the Artificial Ear of Type 3.2H:

The frequency response of the artificial ear of type 3.2H is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

» Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_HL.ADA" from the manufacturer’s calibration disk to a
USB stick or a CD-ROM or make this file available on a network drive via
LAN.

» Call the routine “Calibration - DRP to ERP Correction - Type 3.2 High
leak”. Browse to the file “OES_HL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer,
or when the “3GPP” directory has been renamed or removed.

Calibration of Ear Type 3.3

» Connect the sound level calibrator tightly to the artificial ear using the
adapter UA-1546 and switch the calibrator on.

> Select “Calibration - Artificial ear - HATS Type 3.3” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2L is
used as currently selected.
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Reading the Calibration Data of the Artificial Ear of Type 3.3:

Call the routine “Calibration > DRP to ERP Correction > Type 3.3
—2>From ITU-T P.57 Table 2b”. This procedure needs only be repeated
when the “3GPP” directory has been renamed or removed.

Calibration of Ear Type 3.4

» Remove the pinna and the ear canal simulator, connect the sound
level calibrator tightly to the artificial ear using the short steel adapter
and switch the calibrator on.

» Select “Calibration > Artificial ear > HATS Type 3.4” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20s before restarting the
measurement.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2L is
used as currently selected.

Reading the Calibration Data of the Artificial Ear of Type 3.4:

Call the routine “Calibration > DRP to ERP Correction > Type 3.4
- From ITU-T P.57 Table 2b”. This procedure needs only be repeated
when the “3GPP” directory has been renamed or removed.

Calibration of Artificial Mouth

Before a mobile phone can be tested, the absolute sensitivity and frequency
response of the artificial mouth have to be measured and corrected with the
aid of a previously calibrated pressure-field microphone. The measuring
microphone removed from artificial ear type 1 can be used for this purpose
or an additional microphone capsule is screwed to the microphone
preamplifier. The standard microphone is used as a reference for
determining the frequency response of the mouth. The frequency response
of the microphone can be ignored in the test frequency range (100 Hz to
8 kHz) (see also calibration certificate of microphone capsule).

Since interfering sound falsifies the corrections, the artificial mouth must be
calibrated in the sound-proof test chamber.

First of all, the measuring microphone has to be calibrated.
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» Select a reference microphone type with “Calibration > Artificial
mouth = Select reference mic”.

For the selected microphone type, a device must be selected and
calibrated (see above). This device must be connected to R&S UPV
analyzer input 1 via power supply/conditioning amplifier.

If the selected reference microphone is a diffuse field type (e.g. B&K
4131 or 4134) or a microphone from a Type1 artificial ear, fit the
microphone at right angles to the mouth at the mouth reference point
(MRP) using the gauge supplied with the mouth (positioning at right
angles is necessary because diffuse field or pressure-calibrated
microphones have a flat frequency response to sound from random
incident direction and therefore exhibit an emphasis on high frequencies
with frontal sound incidence).

If the selected microphone is a free field microphone, it must be
mounted in the axis of the sound outlet of the artificial mouth.

> Call the calibration routine with “Calibration = Artificial mouth >
LRGP ITU-T P.51” or “Calibration = Artificial mouth > HATS ITU-T
P.58” from the main menu.

The sound pressure generated at the MRP is set to exactly -4.7 dBPa in an
automatic measurement routine at 1 kHz. The generator voltage required is
stored in a file on the hard disk and used as a reference for all subsequent
settings with the same artificial mouth. If the sound pressure cannot be
adjusted to -4.7 dBPa, an error message is displayed with a request to
check the connection of the artificial mouth and to repeat the measurement.
A possible error source would be that the transformer supplied is not
connected between the generator and the artificial mouth.

The uncorrected frequency response of the artificial mouth is measured
and displayed. Next, the frequency response is measured with the
inverse frequency response correction automatically selected in the
generator (equalization). Residual errors caused by nonlinearities of the
speaker in the mouth are measured and taken into account in the final
equalization file as fine correction.

To verify the results, the absolute sound pressure versus frequency is
measured at a sound pressure of 4.7 dBPa (reference value for most of
the measurements). The absolute sound pressure at each frequency
must be within a tolerance band of +0.2 dB. Correct calibration without
interfering sound yields an almost straight line in the middle between the
two limit lines.

Calibration of CMU Speech Coder

The calibration of the speech coder and decoder is necessary to be able to
calculate absolute loudness. Calibration has to be performed only once and
must be repeated only if the CMU used is replaced. If the CMU is equipped
with model 14 of the Link Handler CMU-B21, GSM as well as WCDMA use
the same paths. Calibration of the coder is therefore identical for both
operating modes and need not be repeated when switching from GSM to
WCDMA or vice versa.
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If GSM / WCDMA and cdma2000® tests are done alternately, separate
calibration devices have to be generated for the two link handlers (i.e. with
and without the supplied adapter).

Note that encoder and decoder are handled as separate devices but
calibrated with one routine.

Auxiliary settings required for calibration can be found in the CMU under Bit
Stream (for GSM) and under BS Signal, Dedicated Channel, Voice settings
(for WCDMA) (firmware version 3.50 or higher). Call the calibration routines
with “Calibration - Codec” from the main menu.

The following information is displayed:

Establish call and set 'Bit Stream’ to 'Decodercal'l

Fig. 12 Message box during decoder calibration

Set up a call to the mobile phone. Set bit stream or voice setting on the
CMU to "Decoder Cal" and then click the “OK” button.

The actual voltage at the decoder output of the CMU is now measured for a
digital full-scale signal and the required correction value is calculated and
saved in the R&S UPV. The following request is then displayed:

Set ‘Bit Stream' bo ‘EncoderCal't

Fig. 13 Message box during encoder calibration

After the “OK” button has been clicked, the input sensitivity of the speech
coder is measured and the input voltage required for digital full scale is
measured at the speech coder and saved in the R&S UPV
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5 Data Entry for Reporting

Operator

Under “Data->Operator” an operator’'s name can be entered which is stored
in association with all calibration and measurement results. If “Operator” is
activated in the report settings, the name will appear in all reports about
these measurements.

Test object

Under “Data > Test object > New” a description of the device under test
can be entered.

o

M amne

|
Type

b anufacturer

Senal Mumber

Cancel | | Save and cloze !ﬁ

Fig. 14 Window for input of information about a test object

With “Data - Test object > Select” one of the entered test objects can be
selected. The data of this selected test object will be stored in association
with all measurements and appear on the associated reports if “DUT
information” is activated in the report settings.
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General

Special problems caused by the coding and decoding algorithms of mobile
phones are encountered when measuring acoustic characteristics.
Vocoders are used to attain the lowest possible data rate. Mobile phone
voice codecs are optimized for transmitting human speech with low data
rate. Not the actual voice signals but only the filter and fundamental
parameters required for signal reconstruction are transmitted.

Purely sinusoidal tones normally used for audio measurements cannot be
transmitted with such a system. Therefore, the coder and decoder had initially
been excluded from the measurement, which required a specially prepared
test mobile phone with a specific test interface.

In commercially available mobile phones, this interface is not accessible;
measurements during normal operation can therefore only be performed via
the air interface with the speech coder and decoder included. With 3rd
generation mobile phones a digital audio interface is no longer provided
even for type-approval testing. As mentioned above, measurements using
sinusoidal tones cannot be performed because the static sinusoidal input
signal becomes a more or less stochastic output signal as a result of
coding, particularly in the medium and high audio frequency ranges.

Signals similar to voice therefore have to be used for the measurement, i.e.
either artificial voice according to ITU-T P.50 or a multitone signal according to
ITU-T P.501 is possible. At the same time, modulation of the signal in time must
largely correspond to voice, since many modern mobile phones use algorithms
for interference suppression which use the modulation to distinguish the useful
from the interfering signal.

The test routines in the R&S UPV-K91 use an amplitude-modulated multitone
signal according to ITU-T P.501 as described in 3GPP TS 26.132 for echo loss
measurement.
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Functionality and control of the measurement macros

@WF‘ Sending Handset [_[O] x

a Margin = 3.25 dB

Sending sensitivity [dB re 1V/Pa]

Frequency [Hz]
B Measued SLR =975 8 [ Upper imit [ Lowe: it
Mo Standard Type 32 Low Leak ArtEa | CMU / CRTU Sample test object
Save curve as I Load curve S‘"::‘F;e . | ma:;ﬁ c Entes | Change Scale Create Report Close

Fig. 15 Example of a measurement window

When a measurement macro is started, e.g. from the “Measurement’
menu, the standardized measurement is immediately executed. With a
single measurement, the window of the measurement macro stays open
after the measurement is terminated. At that time, the following functionality
is available:

Lo ot
N[y Eael ]
Shows Cursar

Change Scale
Data Point Size
Cornrnent

Fig. 16 Context menu of the graph window

Zooming

When the “Shift” key on the keyboard is pressed, the mouse cursor
changes to the zoom cursor. When the left mouse button is pressed, a
rectangle can be marked in the graph. As soon as the left mouse button is
released, the graph is zoomed into the area of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step.
“Unzoom” zooms completely out to the original scaling.
Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper
and lower bounds of both axes can be entered by numbers.
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@Ehange Scale =]
# binirmum = b arimunm
| 100. EIIII::I | 1 IIIEIEIIZI.EIEI::I
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| S000=] | 0.00=]
Cancel ok |
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o

Fig. 17 Window for changing the scale of the graph

Cursor

When the item “Show Cursor” is marked in the graph context menu, a
cursor is displayed which can be dragged along the graph with the mouse.
X and Y values of the data points below the cursor are displayed.

Data Point Size

“Data Point Size” in the graph context menu opens a window in which the
size of marks at the measured data points can be specified. Moving the
mouse cursor over one of the marks causes the associated X and Y values
to be displayed.

Making Additional Measurements

The softkey “Add Measurement” triggers another measurement according
to the specification of the test. Loudness ratings and noise values are
calculated and displayed in the legend. However, limits are not checked,
and the report shows only the original results.

This function can e.g. be used to find the correct volume setting to pass
nominal RLR. It can further be used for adjustments in the device under
test.

Storing and Loading Curves

All curves in the graph can be stored to an ASCII file, and such curves can
be loaded back into the graph. The softkey “Store Curve” opens a window
in which a combo box offers choice between the legends of all curves in the
graph. The curve associated in which the selected entry is stored to the file
at the specified location.

Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a
R&S UPV format limit file with a specified shift in Y axis direction. This
functionality can be used to generate limit curves from “golden” devices for
evaluation purpose.

Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph
context menu, a comment can be entered and edited which will appear in
the report about the respective measurement.
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Creating a Report

The softkey “Create Report” causes a report to be prepared. The report
preview window (see below) opens and shows the preview of the report.
Buttons in the preview window allow to print the report or to export it to PDF,
WORD, EXCEL or Rich Text format.

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is
returned to the R&S UPV-K9 main window. All relevant data associated with
the measurement is imported to the results data. A new entry appears for
the measurement as new row on the bottom of the overview data grid in the
main window.

Notes on Individual Measurements

Sending Frequency Response and Loudness Rating

(“3GPP Sending Handset”)

Sending Frequency Response

The sending frequency response is specified as the transmission ratio in dB
of the voltage at the decoder output to the input noise pressure at the
artificial mouth.

The mobile phone under test is installed in the LRGP (loudness rating
guard-ring position) according to ITU-T P.76, and the receiver is sealed to
the artificial ear.

Tones with a sound pressure of -4.7 dBPa are created with the artificial
mouth at the MRP (mouth reference point), and the corresponding output
voltage is measured at the CMU speech decoder output and evaluated.

The sending frequency response must be within the limit lines specified
according to table 1 of 3GPP TS 26.131. The absolute sensitivity is not yet
taken into account.

Table 1 Limit lines according to table 1 of 3GPP TS 26.131

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 -12
200 0
300 0 -12
1000 0 -6
2000 4 -6
3000 4 -6
3400 4 -9
4000 0
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The offset of the measured frequency response to the upper or lower limit line is
calculated and then the whole limit template is shifted to be centered with
respect to the measured curve. Then another limit check is performed. If the
shifted curve is now within the limit lines, PASS is output, otherwise FAIL is
displayed. The limit check is performed at each measured frequency. If the
measured value and the end point of a limit line are not at the same frequency, it
may happen that the trace slightly crosses a corner of the limit line although
there are no limit violations. The remaining margin is displayed. A negative
margin shows the amount of limit violation.

Sending Loudness Rating

The sending loudness rating (SLR) takes into account the absolute
loudness in the transmit direction and weights the tones in compliance with
the normal sensitivity of the average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 are evaluated according
to table 1 of ITU-T P.79.

Table 2 Frequencies (Hz) of bands 4 to 17 according to table 1 of ITU-T P.79

200 1000
250 1250
315 1600
400 2000
500 2500
630 3150
800 4000

The sensitivity at each frequency is defined as the ratio dBV/Pa referenced
to the rated internal level in dBmO, and the sending loudness rating is
calculated according to formula 5-1 of ITU-T P.79. Note that loudness rating
values are loss values, i.e. a high loudness rating values indicates a low
gain and a low loudness rating value indicates a high gain.

Due to the input sensitivity tolerance of the CMU speech coder, the
individual sensitivity of the CMU used has to be taken into account in order
to calculate the sending loudness rating (see calibration routines).
According to 3GPP TS 26.131, the sending loudness rating should be
between 5 dB and 11 dB, with lower dB values corresponding to greater
loudness (5 dB = maximum loudness, 11 dB = minimum loudness). The
measured SLR is indicated in a window in the frequency response display
and checked for compliance with these limits. In addition to the numeric
value, either PASS or FAIL is displayed.

The general PASS or FAIL information is obtained from the limit check of the
frequency response curve and the loudness rating. PASS is output only if both
the curve and the loudness value are within tolerances.
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@WF‘ Sending Handset [_[O] x

se Margin = 3.25 dB

Sending sensitivity [dB re 1V/Pa]
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Frequency [Hz]
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Fig. 18 Sending frequency response with SLR value displayed

Receiving Frequency Response and Loudness Rating
(“3GPP Receiving Handset, nom. Vol.”, “3GPP Receiving Handset, max, “.
Vol.” 3GPP Receiving Handset, min. Vol.”)

The following three measurement definitions are available, as the
permissible limit values of the loudness rating depend on the volume set in
the mobile phone under test: “3GPP Receiving Handset, nom. Vol” checks
loudness rating limits for nominal loudness setting and at the same time
compliance with the frequency response limit template. “3GPP Receiving
Handset, max. Vol.” checks the receiving loudness rating at the highest
volume setting against a minimum. “3GPP Receiving Handset, min. Vol.”
checks the receiving loudness rating at the lowest volume setting against a
maximum. (Note: As the loudness rating is a loss value, a high RLR is
associated with a soft speech signal and a low RLR is associated with a
loud speech signal).

Receiving Frequency Response

The receiving frequency response is specified as the transmission ratio in
dB of the sound pressure in the artificial ear to the input voltage at the
speech coder input of the CMU. The measured sound pressure is
referenced to the ear reference point (ERP). For ear type 1, the measuring
microphone is directly applied to the ERP and no further correction is
required. For ear types 3.x, the measuring microphone is applied to the
drum reference point (DRP), which is the reason why any measured value
has to be converted to the ERP by means of calibration factors. According
to 3GPP TS 26.132, the measurement may be referenced to the drum
reference point (DRP) even in special cases. For this purpose there are
separate measurements supplied with R&S UPV-K91.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the
HATS. In case of ear type 1, the receiver is sealed to knife edge of the
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artificial ear. In case of ear type 3.2, the receiver is sealed to the rubber
gasket of the artificial ear. If the low leak version of this ear type is used,
care must be taken that the defined leak opening at the circumference of
the artificial ear is not accidentally covered.

The speech coder is driven such that tones with a system reference level of
-16 dBmO are obtained. The sound pressure in the artificial ear is measured
and evaluated.

Ear type 1 will no longer be used for measurements on 3GPP mobile
phones. Therefore, 3GPP TS 26.131 defines limit values only for ear types
3.x, whereas the limit values specified in 3GPP TS 51.010 (previously GSM
11.10) are still valid for ear type 1.

Table 3 Limit lines according to table 30.2 of 3GPP TS 51.010 (ear type 1)

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 -12

200 0

300 2 -7

500 * -5

1000 0 -5

3000 2 -5

3400 2 -10

4000 2

* Intermediate values are obtained by drawing a straight line between the specified values
and using a logarithmic frequency scale and a linear dB scale.

Use tests “3GPP GSM Rel. 4 Receiving Handset, nom. Vol”, “3GPP GSM
Rel. 4 Receiving Handset, max. Vol”’, “3GPP GSM Rel. 4 Receiving
Handset, min. Vol” for receiving tests with type 1 artificial ear.

When ear type 1 is used, the receiving frequency response must be within
the limit lines specified in table 30.2 of 3GPP TS 51.010. When ear type 3.x
is used, it must be within the limit lines specified in table 2 of 3GPP TS
26.131. In the frequency response curve, the limit template is shifted to be
centred with respect to the displayed absolute sensitivity.
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Table4  Limit lines according to table 2 of 3GPP TS 26.131 (ear type 3.x)

Frequency (Hz) Upper limit (dB) Lower limit (dB)
70 -12

200 2

300 * -9

500 * *

1000 * -7

3000 * *

3400 * -12

4000 2

* Intermediate values are obtained by drawing a straight line between the specified values
and using a logarithmic frequency scale and a linear dB scale.

The margins of the measured frequency response to the upper and lower
limit lines are calculated separately, and then the whole template is shifted
such that the resulting margins to upper and lower limit are equal. Then
another limit check is performed. If the shifted curve is now within the limit
lines, PASS is output, otherwise FAIL is displayed. The limit check is performed
at each measured frequency. If the measured value and the end point of a limit
line are not at the same frequency, it may happen that the trace slightly crosses
a corner of the limit line although there are no limit violations. The remaining
margin is displayed. A negative margin shows the amount of limit violation.

Receiving Loudness Rating

The receiving loudness rating (RLR) takes into account the absolute
loudness in the receive direction and weights the tones in compliance with
the difference between an average speech spectrum and the normal
threshold of hearing in quiet of the average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 are evaluated according
to table 1 of ITU-T P.79.

Table 5  Frequencies (Hz) of bands 4 to 17 according to table 1 of

ITU-T P.79
200 1000
250 1250
315 1600
400 2000
500 2500
630 3150
800 4000

The sensitivity at each frequency is specified as the ratio dBPa/V
referenced to the rated internal level, and the receiving loudness rating is
calculated according to formula 5-1 of ITU-T P.79.

Due to the input sensitivity tolerance of the CMU speech decoder, the
individual sensitivity of the CMU used has to be taken into account in order
to calculate the receiving loudness rating (see section “Calibration” above).

The receiving loudness rating depends on the receiving loudness set on the
mobile phone under test and, according to 3GPP TS 26.131, should be
between -1 dB and +5 dB at a rated loudness setting, with lower dB values
corresponding to a higher loudness.
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The RLR must not fall below -13 dB when maximum loudness is set on the
mobile phone. To prevent damage to the human ear, the maximum
receiving loudness must not exceed a certain value.

The measured RLR is indicated in a window in the frequency response
display and checked for compliance with these limits. In addition to the
numeric value, either PASS or FAIL is displayed.

With “3GPP Receiving Handset, nom. Vol”, the general PASS or FAIL
information is obtained from the limit check of the frequency response
curve and the loudness rating. PASS is output only if both the curve and the
loudness value are within tolerances.

“3GPP Receiving Handset, max. Vol” checks only the RLR against a
minimum of -13 dB. The frequency response curve is shown for information
only.

“3GPP Receiving Handset, min. Vol” checks the RLR against a maximum
of +18 dB.

@WF‘ Receiving Handset, nom. Yol [_[O] x

se Margin = 4.50 dB

Receiving sensitivity [dB re 1 Pa/V]

Frequency [Hz]
BB Messued ALR =215 [ Upperimit [l Lower imit
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Save curve as I Load curve S‘"::‘F;e . | ma:;ﬁ CENG | Change Scale | Create Report | Close

Fig. 19 Receiving frequency response with RLR value displayed

Sidetone Masking Rating (STMR)
(“3GPP Sidetone masking rating’)

The sidetone path is the deliberate output of a part of the signal picked up
by the microphone to the phone's receiver. This is to create a natural
hearing impression for the person speaking on the phone as is encountered
under normal conditions involving an acoustic path between mouth and ear.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.
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The STMR can only be measured according to standard using ear type
3.2 (low leakage) (“3GPP Sidetone masking rating”) or ear type 1
(3GPP TS 51.010 only) (“3GPP GSM Rel. 4 Sidetone Masking Rating”).
Measurements with other ear types can be performed for comparison.

The artificial mouth generates tones with a sound pressure of -4.7 dBPa at
the MRP (mouth reference point), and the sound pressure is measured in
the artificial ear.

The attenuation of the sidetone path is determined at each frequency
according to table 1 of ITU-T P.79, and the sidetone masking rating (STMR)
is calculated according to formula 5-1 of ITU-T P.79 with the weighting
factors of table 3 of ITU-T P.79 taken into account. In addition, the gain of
the sidetone path is displayed as a curve.

When the phone is set to rated receiving loudness, the STMR should be
within 13 db and 23 dB according to 3GPP TS 26.131.

e et ol

Sidetone gain [dB re 1 Pa/Pa]

=

Frequency [Hz]
B Measued STMR - 18.22d8
No Standard Type 3.2 Low Leak At Ea CMU / CRTU Sample test object
Save curve as I Load curve Sav:'&‘\?;e . | m:‘ﬁ c Edum | Change Scale | Create Report Close

Fig. 20 Typical measurement of sidetone masking rating

Echo Loss (TCLw)
(“3GPP Echo loss with training’)

The echo loss is the attenuation between the speech coder input and the
speech decoder output (gain of speech coder + decoder = 1). Normally the
echo loss is caused by internal acoustic coupling between the telephone
receiver and the microphone. Since the echo considerably reduces the
sound transmission quality, it must not exceed a certain value.

The mobile phone under test is suspended in free air in the anechoic test
chamber (previous specifications used the LRGP).
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A modulated multitone signal according to ITU-T P.501 is generated as a
test signal and applied to the speech coder. First, the spectral energy
distribution of the generated signal is measured in the third-octave bands
from 200 Hz to 4 kHz. Then, the spectral distribution in the output signal of
the speech decoder is measured. The echo loss is calculated from the
differences of the bands according to ITU-T G.122. According to 3GPP
TS26.132, the mobile phone under test has to be fed for approx. 10 s with
the male and female version of artificial voice according to ITU-T P.50 prior
to this measurement. This training sequence is to facilitate optimization for
potential echo cancellers. A quicker test without training sequence is
available as “3GPP Echo loss without training”.

The actual gain of the speech coder and decoder must also be considered in
the result. This value is available in the CMU after calibration of the coder. In
addition, the attenuation of the echo path is displayed as a curve.

3GPP TS 26.131 specifies an echo loss of at least 46 dB; mobile phones
with good echo cancellers can meet this requirement. Since the
microphone of the mobile phone under test also picks up any side noise
and treats it like an echo, it is essential that the test chamber is well
shielded against external noise.

@WF‘ Echo loss with training =] 3

Echo path sensitivity [dB]

1000
Frequency [Hz]
B Measued TCLw= 649048
Nao Standard Type 3.2 Low Leak ArtEa |CMU / CRTU Sample test object
Save curve as I Load curve SM‘:.I’LB . | m:“ﬁ CENG " Change Scale Create Report Close

Fig. 21 Typical result of echo loss measurement

Stability Margin
(“3GPP Stability margin”)
The stability margin is measured to test the susceptibility of the phone to

acoustic feedback and instability.

For the test, the telephone is placed on an even, hard board with the
receiver and microphone pointing downwards.

A loop is closed in the R&S UPV between the receiving and the voice
channel, and an overall gain of 6 dB is set. The gain of the coder is
automatically taken into account (see also Echo Loss).
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To activate the loop, a noise signal of -10 dBmO in line with ITU-T 0.131 is
applied for 1 s and then switched off, with the loop remaining closed.

[@3ce Stabilty margin B [=

Listen for audible oscillation.
Press softkey corresponding to
your observation.

No Standard Type 3.2 Low Leak ArtEa [CMU / CRTU Sample test cbject
Oscibation | Uscilarimnotl | | EErIu I E— Croste Flepon =

Fig. 22 Window during stability margin test

The test person has to listen to determine whether any resonances or
oscillations are produced. If there are no oscillations, the minimum
requirements according to 3GPP TS 26.131 for a stability margin of 6 dB
are met.

Sending Distortion

(“3GPP Distortion sending, Rel. 4/5”, “3GPP Distortion sending, Rel. 6”)

The SINAD ratio in the transmit path is measured as a function of the sound
level.

A pulsed sinusoidal tone of 1015 Hz with a pulse length of approx. 340 ms
is used for the measurement. At this frequency, coding yields a sufficiently
stable output signal. Voice recognition continues to be active in the mobile
phone under test due to this pulsating signal.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The test signal is generated with the artificial mouth at the MRP (mouth
reference point) and the SINAD value of the received signal is measured at
the CMU decoder output.

The acoustic reference level (ARL) is defined as the sound pressure which
creates a signal level of -10 dBmO in the transmit channel. An automatic
routine varies the sound pressure at the artificial mouth until the desired
level is attained. This value is then used as a reference for determining the
SINAD value versus level.
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The SINAD value is measured at sound pressures between -35 dB and
+10 dB relative to the acoustic reference level (ARL) and compared with the
limits specified in table 7 of 26.131 of 3GPP.

Signal processing of a modern mobile phone comprises a voice activity
detector which determines whether a voice signal is present or whether the
sending signal just comprises background noise. With such mobile phones
the sending distortion test according to 3GPP TS 26.132 before release
6.0.0 may be failed at low levels because the 1 kHz sinewave test signal is
classified as background noise and suppressed. For this reason the
sending distortion measurement according to release 6.0.0 and onwards
omits levels below -25 dB and starts at high test tone levels gradually
reducing the level. For this release, use “3GPP Distortion sending, Rel. 67,
for earlier releases use “3GPP Distortion sending, Rel. 4/5”.

Table 6  Limit lines specified in table 7 of 3GPP TS 26.131

dB relative to ARL | Level ratio
-25dB 26.6 dB
-20 dB 30.7dB
-10 dB 33.3dB
0dB 33.7dB
7 dB 31.7dB
10 dB 25.5dB

The measurement is performed up to a maximum sound pressure of 10 dBPa
at the artificial mouth if the value 10 dB relative to ARL with 10 dBPa cannot be
attained. The actual trace may therefore end at a lower pressure. This occurs
for mobile phones under test which have a low sensitivity in the transmit

direction.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.

4 3GPP Distortion sending 6.0.0 [_[O] x

Sendng signakta-distortion ratio [dB]

'.'a] 20 -1‘0 0 10 15
Sending signal level [dB relative to ARL]

B8 Measued [ Lower Limit
No Standard Type 3.2 Low Leak ArtEa |CMU / CRTU Sample test object
Save curve as I Load curve S“:'g‘FLe . m:‘ﬁ c Entes Change Scale Create Report Close

Fig. 23 Sending distortion measurement
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Receiving Distortion

(“3GPP Distortion receiving”)

The SINAD ratio in the receiving path is measured as a function of the acoustic
signal level.

A pulsed sinusoidal tone of 1015 Hz is used for the measurement. At this
frequency, coding yields a sufficiently stable output signal.

Voice recognition continues to be active in the mobile phone under test due
to this pulsating signal.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The test signal is applied to the input of the CMU speech coder, and the
SINAD value of the sound pressure in the artificial ear is measured with
psophometric weighting according to ITU-T G.714.

The SINAD value of the sound pressure is measured at levels between
-45dBmO0 and 0 dBmO and compared with the limits given in table 8 of
3GPP TS 26.131.

Table 7 Limit lines specified in table 8 of 3GPP TS 26.131

Level Level ratio
-45 dBm0 17.5dB
-40 dBm0 22.5dB
-30 dBm0O 30.5dB
-20 dBm0 33.0dB
-10 dBmO 33.5dB
-3dBm0 31.2dB
0dBmO 25.5dB

The measurement is performed up to a maximum sound pressure of
10 dBPa in the artificial ear; the actual trace may end at an earlier point.

If the operator desires to see the receiving distortion value at the point
exceeding 10 dBPa, this can be achieved by pressing the “add
measurement” button. This causes the measurement to be repeated at all
specified levels. The second measurement is not taken into account for
reporting and Pass/Fail decision.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.
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@WF‘ Distortion receiving [_[O] x

Receiving signal-to-distortion ratio [dB]

|
50 -40

-30 -20 A0 0
Recening signal level [dBm0]
B8 Measued [ Lower Limit
No Standard Type 3.2 Low Leak ArtEa |CMU / CRTU Sample test object
Save curve as I Load curve S“:'g‘FLe . | m:‘ﬁ | c Entes Change Scale Create Report Close

Fig. 24 Typical result of receiving distortion measurement

Idle Channel Noise Sending
(“3GPP Idle channel noise sending’)

The noise voltage at the speech decoder output is measured with the
phone set up in a quiet environment (<30 dB(A)).

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The decoder output voltage is measured, weighted psophometrically
according to ITU-T G.223 and recalculated for the internal level in dBmOp.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied. The noise level is measured during the signal
pauses. The voice activity decoder (VAD) is activated and the mobile phone
remains in the active normal sending mode.

The idle noise level should not exceed -64 dBmOp. The measured noise
voltage is also displayed as a spectrum, making it easier to find causes if
the limit value is exceeded.
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(@ 36PP 1dle channel g =] 3|

Idle Channel Noise Sending = -72.32 dBmO(P)

COITT -weighted spectrum [dB]

100 |
100 1000 10000
Frequency [Hz]

B8 Measued, Noise = -72 32 dBPalA)

No Standard Type 3.2 Low Leak ArtEa |CMU / CRTU Sample test object
Save curve as I Load curve S“:'g‘FLe . | m:‘ﬁ | c Entes Change Scale Create Report Close

Fig. 25 Typical result of sending noise measurement

Idle Channel Noise Receiving

(“3GPP Idle channel noise receiving, nom. Vol”, “3GPP Idle channel noise
receiving, max. Vol’)

The sound pressure in the artificial ear is measured with the phone set up in
a quiet environment.

The mobile phone under test is installed in the LRGP (ITU-T P.76), and the
receiver is sealed to the artificial ear.

The sound pressure in the artificial ear is measured with A-weighting on.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied to the speech coder input. The noise level is
measured during the signal pauses. The voice activity decoder is activated
and the mobile phone remains in the active normal receiving mode.

With rated loudness set on the mobile phone, the sound pressure should
not exceed -57 dBPa(A). In this case use test “3GPP Idle channel noise
receiving, nom. Vol”.

At maximum receiving loudness, the sound pressure should not exceed
-54 dBPa(A). In this case use test “3GPP Idle channel noise receiving, max.
Vol”.

The measured noise voltage is also displayed as a spectrum, making it
easier to find causes if the limit value is exceeded.
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@WF‘ Idle channel noise receiving, masx. vol. =] 3

A-weaghted spectium [dB]

100 - | |
100 1000 10000

Frequency [Hz]

B8 Measued, Noise = -60.75 dBPalA)

Nao Standard Type 3.2 Low Leak ArtEa |CMU / CRTU Sample test object
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Fig. 26 Typical result of receiving noise measurement

This measurement makes high demands on the sound insulation of the test
chamber and the S/N ratio of the measuring microphone including
preamplifier in the artificial ear. A comparison measurement with the test
mobile phone switched off or without a DUT shows the measurement
reserves of the test equipment. Due to the inherent noise of the Audio
Analyzer R&S UPV, measurements can be made to about -80 dBPa(A) at
0 dB microphone gain, and even to lower values when a higher microphone
gain is set.
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7 Automatic Test Sequences
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@ Telephone Tests

File Data Calibration Measurement | Sequence Report  Options  Help

Testresults overiew Mew
Fiepart | T¢ OpEn .. | Measureme
Il | — C F20 INNC C-1 7770 Dhd ZOD Cmed

Fig. 27 Sequence menu

Creating and Editing a Sequence

The menu item “Sequence - New” first produces a window where a name
for the new sequence has to be entered. Subsequently the sequence
window opens.

@ Telephone Tests _[O] x]
File D[ata Calbration Measurement Sequence Report Options Help
$ Sequence sample
3GPP Echo lass without training | 3GPP Sending Handset
3GPP Echo koss with training Append -> Y 3GPP |dle channel noise sending
3GPP Distortion recedving N
3GPP G5M Rel. 4 Recening Handset, max. Vol Edit and Append - el Y Distoion aending Rel. B
3GPP GSM Rel. 4 Recenving Handzet, min. Vol
3GPP G5M Rel 4 Receiving Handzet, nom. Vol
3GPP Receiving Handset, max, Vol
3GPP Receiving Handzet (@ DAP, max. Vol Delete X |
3GPP Recerving Handset, min. Yol
3GPF Receiving Handset & DAP, min. Vol
3GPP Receiving Handset, nom. Vol Move wp
3GPF Receiving Handset @& DRP, nom. Vol
IGPP |dle channel noise recening, mas. vol Move down
3GPP |dle channel noise recenang, nom. vol
3GPF Distortion scﬁ Fiel 4/5 Edit Parameters |
3GPP Sending Handset
3GPP |dle channel noise sending
3GPP Stability margin Clear |
3GPP Sidetone Masking Rating
Echo loss with modulated multisne
Recening Handzet with modulsted multizine
Sending with modulated multisine —I Check all
Distortion recefving
Idle channel noise receiving
Distortion sending Uncheck all
Idle channel noise sending
Stability margin
Save sequence az |
No Standard [Type 32 Low Leak At Ear |CMU / CRTU ' Sample test obiect
To fust | Start | Stop/Cont | Next Step | HF':P“”‘“ s““”" Save sequence |  Save and closs

Fig. 28 Sequence window

Initially the right checked list box is empty. The list box on the left side
displays all available measurement definitions. A measurement is
appended to the sequence by highlighting it in the list box on the left side
and clicking the “Append” button. Subsequently a measurement, which is
highlighted in the checked list box on the right side, can be moved within
the sequence using the buttons “Move up” and “Move down” and deleted
from the sequence with the “Delete X” button. For non-standard
measurements which allow to change parameters like limit curves, it is
possible to edit the parameters before appending the measurement to the
sequence. This is done by clicking the button “Edit and append”. It is for
example possible to assemble a test sequence which contains stability
margin tests with different loop gains.
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Opening an Existing Sequence

The menu item “Sequence - Open ...” opens a file selector for specifying
the sequence to be loaded. The sequence window opens with the specified
sequence loaded. The sequence can then be edited and/or run.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked measurements
in the right list box are executed in sequence. The state of the checkboxes
may be altered by marking a measurement and then clicking on the
checkbox.

Reporting on Sequence Results

A report on all executed measurements of the last run sequence is
prepared and displayed after the “Report Sequence” softkey has been
pressed. After the sequence window has been closed, a report on the last
sequence can be obtained by pressing the “Report last sequence” softkey
in the main window.
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8 Reporting, Storing, Loading and Deleting Results

1402.0043.12

Result Files

Measurement results are stored together with all associated data in XML
files. Separate files can be used for different projects or operators. They
can be archived together with other project data and re-opened later for
generating reports.

It is recommended to keep result files small and to generate backups at
frequent intervals.

@Telephune Tests

File Data Calibration Measurement Sequence FRepork  Opkions  Help

Open resulks File

Save resuls | Measurement title
SERBTEALS ..as b Fhd AGPF Receiving Handzet, nom. ol
e Eals s B P AGPF |dle channel noize receiving, nom. wc
Load sektings e P AGPFP Sidetone Masking Rating
Save sekkings N AGPP Distortion receiving
Save settings as [ Fhd 3GPF Sending Handzet
_ H Ph AGPP Distartion zending Rel. &
2t Pr AGPF |dle channel noize sending
| | as90ne 29940 Dk AZPE Baraiinn Hamdeat rie Ll

Fig. 29 File menu

A new (empty) result file can be created with “File > New Result File” from
the main menu.

An existing result file can be opened with “File > Open Result File” from
the main menu.

A currently opened result file can be stored under a new name with “File >
Store results as” from the main menu.

Report Settings

With “Report = Settings” or “Options = Report settings”, a selection can be
made of data which should appear in the reports. Thus, information which is
the same for a larger number of measurements does not have to be printed
with every report again.

Generating a Single Report

A report on a single measurement result can be generated from the window
of a measurement macro by clicking or pressing the softkey “Generate
report”.

From the result overview of the main window, a report on a single
measurement can be generated by marking the row with the selected result
by clicking on the row header to the left, right-clicking into the data grid and
selecting “Generate report” from the context menu.
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Subsequently data associated with the selected measurement is
assembled, a graph for existing curve data is generated, and the preview
window is opened. Depending on the amount of measurement data, this
may take a few seconds.

Generating a Sequence Report

A report on a sequence of measurements can be generated from the
sequence window by clicking or pressing the softkey “Report sequence”.

Once the sequence window has been closed, a report on the last executed
sequence can be generated by selecting “Report > Last sequence” from
the main menu. Reports about previous sequences can be generated as
single reports on the measurements of this sequence, as all results appear
in the overview data grid in the main window.

Preview Window

@F.cpnrl E !E E
AP NS0 ET= QA
ManFlepart |
=
JGPP Digtortion receiving
e S
Device Under Test:
Comment:
Verdict: PASS
3"
|~
Current Page No: 1 Total Page Nao: 1+ Zoom Factor; 50%

Fig. 30 Report preview window

The main area of the preview window shows a preview of the report as it
will be printed or appear in an exported PDF file. If the report comprises
more than one page, the pages can be browsed using the buttons

LI

To open the print dialog for installed windows printers click

&

To open a file selector for export of the report to PDF, WORD, EXCEL or
Rich Text format, click

e

The scale of the document in the preview can be adjusted with
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Fig. 31 Scale menu of the preview window

Storing and Loading Curves

Measured curves can be stored from and loaded into the graph of a
measurement macro (see above). This allows easy import into
spreadsheets as well as direct comparison of curves measured at different
times or places. Measured curves can also be stored in a R&S UPV limit
file for use as a limit curve either in a R&S UPV sweep graph or in the
graph of a R&S UPV-K9 window. This allows e.g. to derive tolerance
schemes from “golden devices”. The measured curve can be arbitrarily
shifted before being stored.

Shift Curve by n0—= db

Cancel | ] 3

4

Fig. 32 Input window for defining a shift of a measured curve for storage as
limit curve

ASCII Result Files

When the item “Generate temporary export files” in the “Options” menu is
checked, the standard tests generate “abscurve.exp”, “relcurve.exp” and
“result.exp” files similar to those generated by UPL-B9. These files are

always deleted and overwritten by subsequent tests.

Deleting Results

It may be desirable to delete results of selected measurements from the
result file, e.g. because the measurement was repeated due to a missing
call to the mobile, a wrong setting etc. To delete the result of a particular
measurement, mark the row for the selected measurement in the data grid
of the main window by clicking on the row header to the left, right-click into
the data grid and select “Delete result” from the context menu. After
confirmation by the operator, the selected row of the result overview will be
deleted from the result file together with all associated data.
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9 Terminating the Application

The measurement can be terminated from the main window with the “Exit”
softkey. This causes the result file to be written to the hard disk.
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10 Appendix A Settings on the Radio Communication Tester
CMU200

Firmware 3.50

Settings for GSM:

Selection of the GSM band:

GSMsoo overview
B Menu Select
— Selection |mummﬂu!§fum view/P/t Normal GMSK | | Hotkeys - Set 1
» Basic Functions * Nor-Signaling + Anatyzericenerator (| RE - B
* 3G UMTS User Equipment |» Signaling + Overview
» AMPS Mabie Station e -
~ GSM Mobile Station Analyzer/Generator
+ GSM400
+ GEM 850 WCDMA UEFDD [
+ GSM 900 | Maximum
* GSM 1800 WCDMA UE FOD 1]
* GSM 1900 Modulation
¥ IMT-2000 Mobie Station ot ]
* TDMA Mobile Station AMPS ]
AnalyzeriGenerator
Modulation
AMPS 5
Modulation
[Enter]

Taking a coupling loss of the antenna coupler into account:

S| GSMooo Overview

B GSMooo Connection Control g
AF Connector Civerview RF Connector Setup
ALK ALXZ
RF3OUT  RF2 RF1 RF
Analyzer 2 2
° o S |
mto °Gemrm1 Ext. Att.
@ » +00a6+150 a8 +0.0 aB Output
Breode | | Handset|s T |
ety | [ Handset ] o B
Speech Ext. Att.
e +00 08+160 @ +00 48|  Input
I e |
Peak
Connection | MSSignal | BSSignal | MNetwork  AFRFQr| Sync.
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Selection of the FR (full rate version 1), EFR (full rate version 2), HR (half
rate version 1), AMR full rate or AMR half rate speech coder:

4| GSMooo overview

B GSMooo Connection Control g

4| GSMooo overview

B GSMooo Connection Control g

47

'h’i

Signal On

Full Rate Version 2 ¥ |

FullRate Version 1 [

FullR ion 2

Half Rate Version 1
FullRate Data 4800
Full Rate Data 9600 -

rlmi

'h’i

Signal On

AMR Half Rate

_Speechcod./Handset Low |
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Selection of the Bit Stream Handset Low setting for the measurements or
Decoder Cal and Encoder Cal for the calibration:

' GSMooo overview Ih ’7

B GSMoo0 Connection Control g Signal On

Full Rate Version 2 ¥ |

e R

Speechcod./Handset Low
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Typical setting with EFR speech coder (corresponds to AMR 12.2) for
measurements in the call established status:

4| GSMooo overview

B GSMooo Connection Control § Call Established

Full Rate Version 2 || |

| SpeechcodrvandsetLows| 2

Settings for UMTS WCDMA FDD:

Selection of mode:

F WCDMA rop Ealnd Modulation IL ’7

E Menu Select
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Setting dedicated channel to voice:

F WCDMA rop E‘I“" Modulation I1 r_h |

E WCDMArop Connection Control g Signal On

Selection of the Speechcodec Low setting and AMR Bit Rate for the
measurements or Decoder Cal and Encoder Cal for the calibration
(selection is possible only if call is deactivated):

F WCDMA rop Ealnd Modulation r_h ’7

E WCDMArop Connection Control g Signal On

Voice

Speechcodec Low
OFF

Selection A

] a7skps
[ siskps
[ sakps
L] e7kps
[ 74ups
[ 785ups
[ 102kps
W 12248
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Mobile phone registered status, codec settings possible:

F WCDMA rop B’I“d Modulation Ih |

E WCDMArop Connection Control g Registered

F WCDMA rop B’I“d Modulation Ih |

E WCDMArop Connection Control § Connected
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